QuimP Guide

Piotr Baniukiewicz, Richard Tyson and Till Bretschneider
Department of Computer Science, Warwick University
Correspondence to Till Bretschneider. Email: Till.Bretschneider@warwick.ac.uk

Version: 17.12.02

Web site: http://www.warwick.ac.uk/quimp

This manual is available on GitHub. Feel free to fork it and make pull requests!
https://github.com/CellDynamics/QuimP-Doc
Contents

1 License 4

2 PDFs and online versions of this manual 5

3 About QuimP 6

4 QuimP - what is new 7
   4.1 Summary ................................................................. 7
   4.2 Changelog ............................................................. 7

5 Installation 8

6 QuimP Workflow 9

7 Cell Segmentation - BOA Plugin 11
   7.1 BOA menu .............................................................. 12
   7.2 BOA segmentation workflow ........................................... 13
   7.3 Filtering the outline .................................................. 17
   7.4 A Few Words on Image Segmentation ................................. 18
   7.5 Binary mask segmentation ............................................ 18

8 Cell Tracking - ECMM Plugin 20
   8.1 ECMM Tracking ....................................................... 20

9 Fluorescence Measurements - ANA Plugin 22

10 Compiling Data - Q Analysis Plugin 24

11 QuimP preprocessing plugins 26
   11.1 DIC images processing .............................................. 26
   11.2 Random Walker Segmentation ...................................... 26
      11.2.1 Random Walker Segmentation Workflow ...................... 30
   11.3 Mask generator ..................................................... 30
      11.3.1 Suggested workflow ........................................... 30

12 Protrusion tracking 32

13 Data Files Explained 34
   13.1 Parameter files - new format vs. old format ....................... 34
      13.1.1 Conversion between formats .................................. 34
   13.2 Parameter Files - paQP Files ...................................... 36
   13.3 Snake Data - snQP files ............................................. 36
   13.4 Frame statistics - stQP files ...................................... 37
   13.5 QuimP Maps - maQP files .......................................... 38
   13.6 Scalable vector graphics output - svg files .................. 39
   13.7 BOA plugins stack configuration - pgQP file ................... 39
14 MATLAB Functions
   14.1 Loading data - readQanalysis.m ......................................................... 40
   14.2 Function Overview ............................................................................. 42
   14.3 Tracking Maps .................................................................................... 42

15 Walkthrough analysis ............................................................................. 44

16 Historical versions
   16.1 QuimP11b .......................................................................................... 46

17 Contact .................................................................................................. 47
1 License

The full text of QuimP license is available at http://pilip.lnx.warwick.ac.uk/LICENSE.txt.

Please, make the following citation in any publication related to our software:

"QuimP [1] used in this study was developed at the University of Warwick with support from BBSRC (BBR grant BB/M01150X/1).

2 PDFs and online versions of this manual

The user manual exists in two versions, final and development. The final documentation is (usually) related to the current official release of QuimP, whereas the development version evolves together with the software, following upcoming features, bugfixes, etc.

The most recent documentation can be downloaded from:

1. Final documentation
   - PDF - http://pilip.lnx.warwick.ac.uk/docs/master/QuimP_Guide.pdf
   - HTML - http://pilip.lnx.warwick.ac.uk/docs/master/QuimP_Guide.html

2. Development documentation
   - PDF - http://pilip.lnx.warwick.ac.uk/docs/develop/QuimP_Guide.pdf
   - HTML - http://pilip.lnx.warwick.ac.uk/docs/develop/QuimP_Guide.html
3 About QuimP


- Since then it has contributed to about 60 publications to date.

- QuimP development is currently funded through BBSRC BBR grant BB/M01150X/1: ‘QuimP software for quantifying cellular morphodynamics’ (PI Bretscheider), Jul 2015-Dec 2018, with Piotr Baniukiewicz as main developer.

- Current development aims at making QuimP a sustainable resource for the biomedical community. This involves releasing QuimP as open source for academic use, creating a number of web tools for collaborative development and improved interaction with users.
4 QuimP - what is new

4.1 Summary

The key features of this version are:

- The ability to save and restore the state of the BOA plugin for cell contour segmentation. Module configuration, plugin settings and current view are saved in the new file format QCONF. To maintain backward compatibility, files in the previous format are can be still generated (refer to section 13). The QCONF file is human readable using the JSON format and contains all data and parameters generated by BOA. This format is also used by other QuimP modules such as ECMM and Q Analysis.

- New image preprocessing plugins:
  - DIC image reconstruction
  - Random Walker segmentation
  - Protrusion analysis

- The BOA plugin can use binary masks generated outside QuimP to create cell outlines (Snakes).

4.2 Changelog

A changelog can be found at the QuimP web page at: http://pilip.lnx.warwick.ac.uk/site/changes-report.html. The current version of QuimP as well as the version history can be viewed directly from the QuimP Bar plugin (Fig. 1).

![Figure 1: The QuimP bar](image)

If you find a bug or have specific feature requests, please contact the QuimP developer:

p.baniukiewicz@warwick.ac.uk
5 Installation

Consult our Wiki page for installation details:
http://warwick.ac.uk/quimp/wiki-pages/
6 QuimP Workflow

There are four stages which are usually performed when tracking cells using QuimP, each handled by a different plugin (Figure 2).

1. Cell segmentation - Performed by the BOA plugin. Cell outlines, represented as a chain of nodes, are extracted from each frame of an image sequence using an active contour. BOA outputs global measures, such as cell centroid displacement, or cell area.

2. Membrane tracking - Performed by the ECMM Mapping plugin. Outlines are mapped between frames to extract local membrane velocities.

3. Measuring Fluorescence - Performed by the ANA plugin. Pixel intensities are sampled from the cell’s cortex, its width defined by the user.

4. Data analysis - Performed by the Q Analysis plugin. Statistics are generated and data are visualised in the form of spatial-temporal maps.

Additionally, there are data pre-processing plugins available such as:

1. DIC\textsuperscript{1} plugin (subsection 11.1)

2. Random Walker Segmentation plugin (subsection 11.2)

3. Mask generator (subsection 11.3)

4. Format converter (subsubsection 13.1.1)

A plugin can be launched from either the [Plugins → QuimP] menu, or from the QuimP bar (opened via [Plugins → QuimP → QuimPBar]). Running a plugin will either require an image and/or a QuimP parameter file (with extension .paQP or .QCONF) generated by BOA (see section 13 for details). Demanded file format can be pre-selected by File Format Selection tick box. This selection influences all QuimP modules, even if started directly from Fiji plugin menu. Plugins must be executed left to right, although steps can be repeated without re-running previous plugins and fluorescence measurements performed by ANA can be skipped entirely.

Once complete, data can be analysed in Excel or MATLAB.

---

\textsuperscript{1}Differential Interference Contrast microscopy
Figure 2: The QuimP bar
7 Cell Segmentation - BOA Plugin

QuimP utilises an active contour method to segment cells from the background of an image. Typically, this will be a time lapse movie containing a fluorescence channel, captured from a confocal microscope, but the BOA plugin will segment any image which has bright objects on a dark background (note that phase contrast images can not be segmented with this method). Attaining the best image for segmentation may require some pre-processing, such as the combining of available fluorescence channels (the ideal case is that of an evenly white cell on a black background). Figure 3 describes the active contour method and provides insight as to BOA’s parameters.

It is expected that objects being segmented have intensity higher than background. Active contour method implemented in BOA will not work for other cases.

Figure 3: Caricature of outline detection using active contours. QuimP’s active contour consists of a chain of connected nodes (a reduced number are shown here for simplicity) initialised to encircle a cell of interest. Three types of forces act on each node; (A) Central forces contribute to chain shrinking; (B) Contraction forces between neighbouring nodes shrink the chain and maintain chain integrity; (C) Image forces oppose the shrinking of the chain by a magnitude determined by the local image intensity gradient (red box). When a node experiences inward forces greater than the opposing image force it moves inwards (D). On reaching the boundary the image force becomes sufficiently large to cancel out the other forces, halting and freezing the node (E). (F) shows the paths of nodes during contraction. Note that nodes can be added or removed (red nodes) to maintain an average distance between neighbours. (G) shows the final position of nodes. QuimP usually makes use of 100 or more nodes to extract high resolution cell outlines. [3]

The BOA window is presented in Figure 4. There are four highlighted areas, which contain tools and allow to adjust settings for segmenting and displaying images, and postprocessing of segmented contours.

- Red: segmentation parameters, described in step 4 below.
- Blue: controls for navigating through frames in a time series and for zooming cells visible in the current frame.
Enabling the tick box labelled Show paths will display a trace of the snake as it contracts. Nodes colour pixels white as they move towards the cell boundary. This view can be useful for diagnosing why a segmentation fails.

Enabling the tick box labelled Zoom cell, will zoom the image to selected cell, and track the zoom to the cell’s movements.

- Green: tools for manual editing of contours.
  - Set Scale - set pixel size and frame rate. These values can be also read from image file if available or set on the BOA start.
  - Truncate seq - allow to truncate segmented sequence.
  - Add cell - segment current ROI. Segmented cell should be included entirely in ROI.
  - Delete cell - delete already segmented cell. This option removes the whole track of the cell across frames.
  - Freeze - exclude cell from further modifications. Changes of segmentation parameters, plugins or segmentation of the whole sequence will not affect frozen cells.

- Yellow: access to cell contour postprocessing filters (described in section 7.3). There are also two buttons here helping in populating current filter stack among other frames:
  - Populate fwd - copy current filter stack (together with configuration of used filters) to all next frames (in contrary to menu Plugin → Populate to all that copy current configuration to all frames).
  - Copy prev - copy configuration from previous frame to the current one.

7.1 BOA menu

- File
  - Load global config - load QCONF configuration file and restore saved state. One can continue work from point where it was saved in.
  - Load plugin preferences - load configuration of outline plugins stack.
  - Save global preferences - save configuration of outline plugins stack.

- Preferences
  - Plot original - switch on displaying original outlines together with those processed by plugins. If there is no plugin active (or selected) it does nothing.
  - Plot head - flag zero node of outline with arrow pointing to the outline direction.
  - Zoom freezes - if set, zoom will freeze all cells except that zoomed in. Un-zoom will release all cells.
  - Show history - open history window.

- Plugin
Figure 4: The BOA Window

- **Discard all** - remove all plugins from all frames. Discard all changes introduced by them to the outline.
- **Re-apply all** - try to reload plugins from disk and apply them to outlines.
- **Populate to all frames** - copy plugin tree from current frame to all other frames and apply it to outlines. Do not run segmentation. This option can be useful together with Binary mask segmentation.

- **Segmentation**
  - **Binary segmentation** - perform binary segmentation on black-white mask
  - **Clear all** - remove all segmentation results and set all parameters to their default values

- **Help**
  - **Help contents** - open system web browser and try to load this manual. Internet connection is required.
  - **About** - display version of QuimP and found plugins

### 7.2 BOA segmentation workflow

**Step 1: Open an image and ensure the correct scale.** QuimP can segment from a single image, or from an image stack (but not from a hyperstack). Only 8-bit images can be used for segmentation and so you will be prompted to convert to 8-bit if required. QuimP uses the scale properties of the
image to scale all output to microns (pixel size) and seconds (frame interval). **ENSURE YOUR SCALES ARE CORRECT** within [Image → Properties...]. On launching, BOA will prompt to check your image scale. The scale is recorded by BOA and stored in the parameter file for use in the rest of the analysis.

**Step 2: Launch the BOA plugin**

Unlike previous versions, BOA no longer requires selection of cells prior to launching, but you can do so. Launch BOA from the QuimP bar or menu. The BOA window is now a fully functional ImageJ window that allows the user to perform any ImageJ function, such as drawing, creating ROI’s, or zooming while the BOA plugin is in use. Figure 4 shows the BOA window. The image scale is displayed at the top right. To adjust the scale click **Set Scale**.

BOA can segment one, or more cells, each beginning and ending at any frame you wish. In addition, you can manually edit any segmentation at any frame, add/delete cells, truncate segmentations, and adjust the segmentation parameters for individual frames.

**Step 3: Adding and deleting cells.**

To add a cell first scroll to the frame that you want to begin the segmentation at (either with the mouse wheel, or slider). Using either the circular, rectangular or polygon selection tool, draw an ROI (region of interest) around a cell, and click **Add cell**. BOA will immediately attempt to segment the cell at the current frame. If convergence is successful, the result is displayed as an image overlay. The cell is also given an identification number. If the segmentation fails for some reason, the parameters can be adjusted (see below). You do not need to re-add the cell.

Additional cells can be added in the same way. The active contours surrounding each cell will interact with one another and prevent contours crossing over to other cells. This capability is particularly useful in situations where cells come into close contact, which often disrupts the segmentation process.

If you are not able to find optimal parameters for many cells at once, you can select only one cell then follow points below and at the end use **Freeze** button to block further modification of this cell. Then repeat the whole process for another cell. Note that **Freeze** freezes the whole sequence and one can has many sequences frozen at one time.

To delete a cell click **Delete cell**, and then click the centre marker of a cell, on any frame where a segmentation is visible. Hit the same button again to leave delete mode.

**Step 4: Adjusting segmentation parameters.** When a parameter is altered, BOA immediately re-computes the segmentation for all cells on the current frame with the new parameters (all cells share the same parameters). Each has a minimum/maximum value that can not be exceeded. To alter a parameter either enter a value into the text box, or use the arrows to increase/decrease in steps. The key to attaining a good segmentation is the balancing of the 3 forces. First, try adjusting the **Image F** parameter to improve the result. Parameters can be set for each frame separately.

The parameters are as follows:

- **Node spacing** - Roughly equates to the number of pixels between nodes, and hence the resolution of the segmentation.
- **Max iterations** - The maximum number of iterations applied to shrink the contour.
• **Blowup** - The number of pixels to expand the solution to the previous frame, for beginning calculation at the current frame (utilised when ‘Use previous snake’ is active). Increase if your target cell is moving by large amounts between frames. Decrease if other cells are coming into close proximity and interfering with the snake. Lower values reduce computation time.

• **Critical velocity** - The cut-off speed at which nodes are frozen. Lower the value to allow the snake to continue to contract for longer, which may aid in letting nodes enter concavities.

• **Image F** - Controls the magnitude of the image force pushing nodes outwards. This is the most effective parameter and should be the first port of call for adjustment. Highly intense cells will produce high image forces, and you may need to lower this value to allow nodes to approach the cell outline. With weakly intense cells the snake may collapse inwards, past the cell boundary, in which case increase the image force.

• **Central F** - The magnitude of the central force pulling nodes inwards. Increase to shrink the snake further and help nodes enter concavities. Decrease to prevent nodes entering the interior of cells.

• **Contract F** - Magnitude of the force pulling nodes together (i.e. contracting the snake). Increase to prevent nodes ‘falling through holes’, or to produce a smoother final solution.

• **Final shrink** - The number of pixel to shrink the solution to tighten the snake to the cell boundary. A value of zero does not shrink the solution at all.

• **Sample tan, Sample norm** - Defines (in pixels) the size of the sampling box around each node within which the image is sampled for calculation of the image force. ‘tan’ describes its width, ‘norm’ its depth. A larger sampling box will increase the size of the image force. Briefly, the sampling box should be an appropriate size as to give an accurate sample of the local intensity between the cell and the background.

• **Use previous snake** - If selected, the solution to the previous frame will be used as the starting contour for the current frame. Otherwise, the users selection is used as the starting contour for every frame.

• **Expanding snake** - Experimental option. Rather than contract the snake, it expands. May be useful for tracking vesicles.

**Buttons and checkboxes:**

Previous segmentation for your image can be loaded back into BOA by hitting load and selecting a QuimP parameter file with the file extension either `.paQP` or `.QCONF`. Parameter values alone can be loaded by declining to load associated snakes. Button **Default** sets above parameters to their default values and recompute current frame. The **Copy prev** button will copy segmentation parameters from previous frame to the current one and re-run segmentation.

Enabling the tick box labelled **Show paths** will display a trace of the snake as it contracts. Nodes colour pixels white as they move towards the cell boundary. This view can be useful for diagnosing why a segmentation fails.

**Step 5: Segmenting multiple frames.** When happy with the segmentation on the first frame, hit **SEGMENT** to segment the cell (or cells) in the following frames. Segmentation parameters from
starting frame will be copied to subsequent frames. Any outlines already existing on these frames will be overwritten. The algorithm may fail at a particular frame and a warning will be printed to the log window, at which point you can alter parameters. This process can be stopped in any time hitting \textit{SEGMENT} once more.

**Step 6: Correcting segmentations.** In the case of failure, or incorrect results, you have 3 options:

- **1 - Edit a solution.** Scroll to a frame where an error occurred, click \textit{EDIT} (If you have more than one cell click its centre). Drag the points of the ROI to the correct locations (you can hold \textit{alt} to delete nodes or \textit{shift to split nodes}). You can zoom using the imageJ tool (magnifying glass). If you lose your ROI go to [\textit{Edit \rightarrow selection \rightarrow restoreselection}]. Scroll to edit other frames. When finished, leave edit mode by clicking *STOP EDIT*.

- **2 - Adjust the parameters.** Scroll to a frame where an error occurred and change the parameters to improve the segmentation. Optionally, click \textit{SEGMENT} to apply these new parameters to the following frames.

- **3 - Truncate segmentations.** Scroll to the first frame where an error occurred and click \textit{Truncate Seg’}. Click the centre of a cell to remove all segmentations from the current frame onwards.

- **4 - Use BOA plugins.** Try to apply available BOA filters for particular frames or for whole stack. Check \textit{Plugin} menu (Section 7.1) and Section 7.3 for details.

You can use also \textit{Zoom freezes} feature from \textit{Preferences} to change \textit{Frame Zoom} behaviour. If \textit{Zoom freezes} is ticked on, \textit{Frame Zoom} freezes all already segmented cells except that currently zoomed. Then any modification will apply only to magnified cell.

**Step 7: Save the results.** Click \textit{Save and Quit}. The saved cell outlines are those visible on the yellow overlay. For new \textit{QCONF} format selected (default) only one composite file is outputted. Otherwise a set of files will be saved for each segmented cell (see Chapter 13 for description differences between new and old data file format). A cell’s ID number is automatically added to filenames.

Enter a name for the analysis (file name extensions are added automatically). BOA outputs files with a \textit{QCONF} extension for new fileformat or \textit{.xxQP} for old one\textsuperscript{2}.

Files extended with \textit{.paQP} contain file paths and parameters associated with a particular analysis. When running other QuimP plugins, it is the \textit{.paQP} file which you must select to continue an analysis (see 13.2).

Files extended \textit{.snQP} contain all data associated with individual nodes of an outline, including pixel coordinates, local cortex intensity, local membrane velocities, and tracking data (see 13.3).

Files extended \textit{.stQP.csv} contain average statistics per frame, and can be opened directly in Excel as a ‘comma separated file’ (see 13.4).

The BOA plugin alone outputs many useful statistics regarding cell morphology and migration, without the need to run any further analysis. Simply open the \textit{.stQP.csv} file in Excel, or use the accompanying scripts to load data into MATLAB (see section 14).

\textsuperscript{2}QuimP11
7.3 Filtering the outline

BOA module supports external plugins for post-processing outlines on current frame. Plugins are standalone jar files that can be developed by other scientists and distributed independently from QuimP. Available plugins are discovered when BOA launches by scanning default location, which is Fiji/plug-ins folder. There is no need of any additional action, discovered plugins are available in filter stack on right (see Fig. 4). There are three slots in the stack. Filters are applied in order from most top to bottom, next filter starts with contours returned from the previous one. Any action on filters relates only to current frame (thus each frame can have different filter stack) unless SEGMENTATION button is clicked. Automatic segmentation propagates most recent configuration (that means all options available in BOA window) from starting frame to all subsequent frames. Modified contour is drawn in standard yellow colour, whereas red denotes original unprocessed result of segmentation (Fig. 5). Any further processing in QuimP workflow (e.g. ECMM or ANA) applies to filtered outline. Refer to section 7.1 for other options related to filters. Frozen cells (Chapter 7) are also excluded from processing by filters.

If filter contains an user interface, it can be accessed by GUI button (Fig. 5).

Default installation of QuimP contains four BOA filters:

- **HatSnakeFilter** Removes small protrusions from outlines.
- **MeanSnakeFilter** Apply running mean filter to outlines.
- **MedianSnakeFilter** Apply running median filter to outlines.
- **SetHeadSnakeFilter** Allow to choose first node in snake.

**RandomWalkSnakeFilter** Perform Random Walk segmentation of frame using Active Contour results (outlines) as initial seed. Refer to section 11.2 for more details about Random Walk.

![Figure 5: BOA filters in action.](image)
• **HedgeHogSnakeFilter** For testing purposes.

Filters that have been discovered and properly loaded are marked in green colour. This is standard behaviour when user start analysis from scratch. If BOA configuration has been restored from QCONF file, filters (if any was used) are displayed in red colour to denote that result of segmentation (that is stored in QCONF file together with raw unprocessed outlines) was processed by filter stack but none of those filters is loaded yet to BOA. In this mode user can browse through frames, check segmentation parameters, etc. even if a filter is physically not available in his configuration. Option Plugin→Re-apply all will try to load all necessary filters from disk and apply them to each frame where they were used. Note that this operation will recompute all outlines on frames where filters were used and replace loaded results with those evaluated.

### 7.4 A Few Words on Image Segmentation

If you run into difficulties attaining a good segmentation, there are a few tricks that may help. If the width of your cell is around 20 pixels or less try artificially increasing the size of the image with some form of pixel interpolation selected ([Image → Adjust → Size]). This should aid sampling of the image and allow nodes to enter concavities with greater ease (note, all subsequent analysis must be performed on the image at the new resolution).

If your images are particular noisy, and cell’s appear very grainy, you may try applying a weak Gaussian blur to smooth them ([Process → Filters → GaussianBlur]). This should make for more reliable sampling of the cell’s interior.

Remember to recalculate the scale of the image when resizing, and to perform intensity analysis on the rescaled image without any interpolation.

Another common approach to improving image quality is to remove background noise using a ‘blank’ image, one taken without any cells in the field. This is particularly useful for removing shadows of dirt on the optical equipment, and correcting uneven backgrounds.

### 7.5 Binary mask segmentation

The QuimP supports creation of Snake outlines directly from binary masks. As the active contour method is not used in this case, one can use another segmentation algorithms (e.g. Random Walker method) to deal with problems that typically occur for active contour such as e.g. bad segmentation of cavities.

To use binary segmentation, the black-white mask (8-bit image in ImageJ) should be prepared first. It has to be size of segmented image that is already loaded to BOA plugin. The number of slices in mask file should be less or equal to the number of slices present in segmented image. The background pixels must have value 0 whereas objects can be defined by any other values within the range 1-255.

The binary segmentation plugin can be launched from BOA menu (Segmentation → Binary segmentation).
Figure 6: The Binary Segmentation Window

The mask can be either loaded from separate file (ImageJ formats are supported) or selected among already opened images in ImageJ. Results of segmentation are displayed in real-time on BOA window immediately after clicking Apply. Cancel closes the plugin window leaving last results of segmentation in BOA. If Clear is selected each use of Apply will clear current outlines in BOA. If it is unselected, outline will be added to BOA. Note that each click on Apply will create new outline even if none of plugin parameters is modified. Resulting outline can be smoothed by e.g. MeanSnakefilter available in the plugin area (see figure 4). Filter can be applied for selected frames only or populated for the whole sequence by (Plugin → Populate plugins)
8 Cell Tracking - ECMM Plugin

To extract data on local membrane velocity QuimP utilise our Electrostatic Contour Migration Method (ECMM). Nodes that form a cell outline at time $t$ are mapped onto the segmented outline at time $t+1$. The distance a node migrates during the mapping process, and the frame interval, determines the local membrane velocity at the node’s position. If you only have a single frame there is no need to run this plugin. ECMM edits and adds to data already contained within an .snQP file.

**Step 1:** Launch the ECMM Mapping plugin, and open the desired .paQP file when prompted. There are no parameters that require manual setting.

**Step 2:** Inspect the results. The blue outline represents the cell outline at time $t$, the green at time $t+1$. Green circles, overlaid with crosses, denote intersection points that have been validated and used for calculating sectors. Red lines denote paths taken by migrated nodes. Nodes that fail to map correctly are highlighted in yellow. Failed node (FN) warnings are displayed along with a running total (in brackets) of the number of failed nodes in the whole sequence. The log window will display progress and warnings.

If a node fails to map it is simply ignored, the effect of this is a small reduction in mapping resolution at the nodes location. If the process fails to map the majority of the nodes correctly, then a new segmentation will have to be performed (try using a different node resolution or changing the image resolution).

8.1 ECMM Tracking

The details as to the workings of ECMM can be found in our publication [3]. The current implementation includes several significant improvements. It is not necessary to understand the method, only the format of the tracking.

At frame $t = 1$ a node is randomly chosen as being node zero, $n_0$. Other nodes are then assigned a position according to their distance from $n_0$ along the cell perimeter. The length of the cell perimeter is normalised to 1, hence the position of a node which is exactly half way around the perimeter will be 0.5 (see figure 7a).

The nodes of the outline at $t = 2$ also have positions assigned, but in addition have an origin. This represents where a node originated from on the $t = 1$ outline. For example, a node with an origin of 0.5 originated from position 0.5, exactly half way around the outline at $t = 1$.

It should be realised that this method of tracking is sub-node resolution. By simply interpolating the positions and origins of nodes, any real number position on an outline can be tracked at sub-node resolution, for as many frames as desired. See section 13.3 for the format of data output, and section 14.3 for using ECMM data within MATLAB.
Figure 7: ECMM tracking method. a) Normalisation of the cell perimeter. b) Caricature of the tracking of node positions between two frames (black $t$, red $t + 1$). Arrows pointing towards the red outline indicate forward mappings and a node’s origin is recorded simply as its position on the black outline. Arrows pointing towards the black outline indicate reverse mapping and node origins are recorded as interpolated values between nodes on the back outline. c) Data from b) as it would appear in a .snQP file. The frame number is followed by the number of nodes in the outline. Speeds are proportional to the lengths of the green mapping arrows.
9 Fluorescence Measurements - ANA Plugin

QuimP samples the intensity of pixels from within the cortical region of a cell. At each frame, nodes of the cell outline are shrunk inwards to form an inner outline. The amount of shrinkage is specified by the user, and relates to the estimated cortex width. Nodes are migrated inwards towards the inner outline, while simultaneously measuring pixel intensities (a 3x3 average). A nodes fluorescence intensity is the maximum recorded as it migrates across the cortex. ANA can record data for up to 3 separate fluorescence channels.

![Image of ANA plugin](image.png)

Figure 8: ANA. The area between the red and blue contours is the user defined cortex, and is where intensity samples are taken. If Normalise to interior is ticked, sampled intensities will be normalised to the average intensity of pixels within the blue contour.

**Step 1:** Open an image stack containing the desired fluorescence channel. This may be the same stack used for cell segmentation, or one containing data from another channel. Ensure the opened stack has the same resolution and number of frames as that used for segmentation.

**Step 2:** Launch the ANA plugin and open the desired .paQP or (recommended) QCONF file when prompted.

**Step 3:** Enter a value for the cortex width ($\mu m$) and choose a channel. The inner and outer outlines are displayed on the image. Changing the cortex width will update the image overlay. Choose a channel to record data in from the drop down menu.

ANA provides 5 further options

- Normalise to interior - Toggle normalisation of intensity sampling to the cells interior (recommended).
- Sample at Ch1 locations - Sample at the same locations as determined for channel 1.
- Clear stored measurements - Removal all fluorescence measurements from QuimP’s files.
• New image with outlines? - Produce copy of input image stack with inner and outer outlines in it. Outlines are drawn at overlay\(^3\). Flatten the image before using it in another software.

• Copy results to IJ table? - Open standard ImageJ table\(^4\) filled with fluorescence statistics computed for selected channel (the same are written to \textit{stQP.csv} file). Note that if an experiment contains more than one cell, ANA will be run for each of them separately but finally the table will always contain statistics for all cells.

• Append results to IJ table - works as \textit{Copy results to IJ table}? but does not clear table before. Can be used for collecting results from different experiments.

Click \textit{OK}.

Fluorescence data associated with specific nodes is saved in the \textit{QCONF} file and additionally in \textit{.stQP.csv}.

**Step 4:** For further channels, open the next channel image and re-run ANA.

---

\(^3\)\url{https://imagej.nih.gov/ij/docs/guide/146-11.html}

\(^4\)Standard table always is named \textit{Results}
10 Compiling Data - Q Analysis Plugin

Data within QCONF file (or .snQP and .stQP for old path) files can be read into Matlab at this point, but motility maps have not yet been generated. The Q Analysis plugin will build spatial-temporal maps of motility, fluorescence, and convexity, and also several other maps to aid analysis. In addition, vector graphics are produced using the Scalable Vector Graphics format. These include a cell track in which all cell outlines are overlaid and coloured according to frame number, and a motility movie in which nodes are coloured with a user specified data type.

Step 1: Launch the Q Analysis plugin and open the desired .paQP file when prompted.

![Figure 9: Q Analysis options dialog](image)

Step 2: Enter parameters to the options dialog. The parameters are as follows:

- **Cell track option - Frame increment** [positive integer]. The frame increment for drawing the cell track (.track.svg). Frames are only draw at the specified increment. Set to 1 for all frames.

- **Cell track option - Colour Map.** Select a colour scheme for the cell track.

- **Motility movie option - Colour using.** Select the data type for use in colouring nodes of the motility movie.

- **Convexity option - Sum over (microns)** [positive real number]. Distance around the cell perimeter (µm) to sum curvature. Set to zero for no summation.

- **Convexity option - Smooth over (microns)** [positive real number]. Distance around the cell perimeter (µm) to over which to average curvature for smoothing. Set to zero for no smoothing.

---

5Refer to section 13
6If old path is selected, otherwise one should use Format Converter tool to obtain these files. Refer to section 13
- **Map option - Map resolution** [positive integer]. A value of \(x\) will produce images that are \(X\) pixels in width. The height of the image will be equal to the number of frames of the analysed sequence, or a multiple of number of frames (if less then \(x\)). Data is interpolated to form maps of any size.

The images produced are for visualisation only, as they have been scaled to fill the RGB colour spectrum. Vertical image scale is set to frames (frame zero at the top), horizontal to the normalised length of the cell perimeter (0,1]. Import `.maQP` files as text images for further analysis in ImageJ. See Section 13.5 for details and analysis of maps.
11 QuimP preprocessing plugins

11.1 DIC images processing

Differential interference contrast microscopy (DIC) enhances the contrast in unstained, transparent samples. DIC images can be easily interpreted and analyzed by biologists due to high resolution available and excellent contrast generated by steep gradients in optical path lengths and phase shifts between the two polarized beams. Nevertheless, very characteristic bas-relief observed in DIC images is the source of problems in automatic analysis of these images. The image contrast and the same the objects boundaries are well defined in the shear angle but in direction perpendicular to it there is no contrast against to background and thus a lack of distinct edges of object. Moreover, strong gradient of image intensity at shear angle negatively influence standard image processing methods like global thresholding or edge detection producing insufficient results, with discontinuous regions or edges.

The DIC plugin provided with QuimP allows to convert DIC samples into form more suitable for segmentation and further image processing. The local contract for any cell in reconstructed image is well defined in every direction and the intensities of pixels take only positive values (in relation to a mean intensity level). The algorithm implemented in QuimP is described in [2]. Either single images or time lapse movies from DIC microscopy can be processed.

Step 1: Open an image. Once loaded into ImageJ/Fiji click DIC filter in QuimP bar. Only 8-bits images are supported (256 gray levels).

Step 2: Set correct parameters There are two important parameters: Shear angle and Decay (Fig. 10). The Shear parameter is the shear angle of DIC microscopy measured counterclockwise, whereas Decay is described in details at [2]. The Decay factor depends mainly on the size of cells and the best results are usually achieved experimentally. Invert output option inverses colorscale in reconstructed image.

Reconstructed image can be affected by linear pattern that can be filtered by running mean filter activated if Filter mask size is greater than 0. Smoothing filter is applied before processing for angle perpendicular to given Shear.

If objects (cells) in reconstructed image are darker than background, the image should be inverted before further processing in BOA module. One can use ImageJ option Edit→Invert or tick Invert output in plugin window. Refer to section 7.

11.2 Random Walker Segmentation

The Random Walks Segmentation algorithm is described in the paper [1]. It belongs to the class of supervised segmentation algorithms what means that the user interaction is needed. In RW method a user has to specify a small set of pixels belonging to the desired object and (possibly) a set of pixels belonging to the background. Those pixels are called seed pixels and in this plugin they form the

7Currently, smoothing can be used only with the following shear angles: 0, 45, 90, 135. For another values it will run for closest multiplicity of 45 degrees.
seed image. The seed image must be the size of segmented image whereas, the number of layers can be either equal to number of layers in segmented image or set to 1.

Segmentation is run in two sweeps. First one gives rough segmentation whereas the second one produces final result. Second sweep uses binary mask produced by the first step as an input after filtering it by selected Binary filter. Second sweep can be disabled by setting Gamma 1 to 0. By default second sweep uses half of defined iteration number.

Implemented algorithm uses iterative scheme with three possible stopping criteria:

1. ITERATIONS - if number of iteration defined in Iterations is exceeded for first sweep or half of this number for second sweep.
2. NANS - if Infs or NaNs appear in solution (they will be removed before presenting result)
3. RELERR - if relative error is smaller than defined. Defined by Rel error.

The RW plugin can be called outside of QuimP directly from the QuimP Bar. The main interface is presented in Figure 11. The window is divided into eight sections:

1. Image section
2. Seeds section
3. Dynamic section that depends on selection in previous section
4. Segmentation options section
5. Inter-processing section
6. Local mean feature section
7. Post-processing section
8. Display options section
Figure 11: Random Walker segmentation dialog

**Image section** - here user can select image that will be segmented. It must be grayscale image either 8 or 16 bits.

**Seeds section** - defines source of the seed image. The following options are available:

- RGB image - user can provide RGB image where foreground pixels are labeled with pure red colour and background with pure green. The z-dimension of the seed image must equal to one or to the number of slices of segmented image. If there is only one slice of the seed given, it will be applied to the first slice of segmented image. For the \( n+1 \) slice the seed will be generated using results of segmentation of \( n \)-th slice processed by algorithm selected in **Inter-processing section**.

- Create image - user can create RGB image cloned from the image selected in **Image section** (Clone button). The FG and BG buttons select foreground and background pen respectively.

- Mask image - user can provide binary image, where white areas will stand for the foreground seed. This mode is intended for using results of Active Contour segmentation as input to Random Walk algorithm. The seed stack should have the same size as segmented image. The foreground labels can be larger than objects they label because they are pre-processed (usually shrunk) by algorithm selected in **Inter-processing section**. Typical use case is to perform rough segmentation in BOA module using fail safe parameters which usually lead to rough segmentation and then to use Random Walk plugin to get fine one. The improvements should clearly visible especially in concave areas where Active Contour method fails. **Note** - providing mask as initial seed usually requires any Shrink method to be set.

- QCONF file - the same as Mask image but user can provide QCONF file saved in BOA module.

**Dynamic section** - its content depends on selected seed source.

**Segmentation options** - controls segmentation process. Options available here:

- **Alpha** - penalises pixels whose intensities are far away from the mean seed intensity

- **Beta** - penalises pixels located at an edge, i.e. where there is a large gradient in intensity. Diffusion will be reduced.

- **Gamma 0** - currently disabled
• **Gamma 1** - set to 0 to skip second sweep. Other values are currently ignored.

• **Iterations** - number of iterations (half of this number for second sweep)

• **Rell error** - Relative error - stopping criterion for iterative Random Walk algorithm

**Inter-processing section** - it controls how binary masks should be transformed to seeds internally. This process applies when seeds are given as results of segmentation from other method (*Mask image* or *QCONF file*) or there is only one slice of seeds provided (*RGB image*). Binary mask is shrunk by algorithm selected in **Shrink method** with **Shrink power**. Results define object’s seeds for next frame. Then, the same mask (unmodified) is expanded by the same algorithm but with **Expand power** and then inverted to define background seeds for the next frame. Options available here are:

• **Shrink method:**
  - **NONE** - no shrinking or expanding. Mask is used directly as seed
  - **CONTOUR** - the ANA contour processing algorithm is used for modifying masks. They are first outlined then vectorised and finally processed. This approach preserves shape of the contour. Parameters **Shrink power** and **Expand power** relate to number of pixels to shrink and expand the contour respectively.
  - **MORPHOLOGICAL** - masks are processed by morphological erosion. Parameters **Shrink power** and **Expand power** relate to number of algorithm iterations.

• **Binary filter** - applied between sweeps. It is intended to remove binary noise, isolated pixels, etc, that could give false seeding:
  - **NONE** - filtering disabled
  - **SIMPLE** - performs one iteration of morphological opening operation.
  - **MEDIAN** - median filtering with kernel of radius 2.

• **Estimate Background** - try to apply simple Otsu thresholding to background seeds. Use **Show seeds** to verify correctness of estimation.

**Local mean** - this option can improve behavior of the algorithm in areas with high gradient of intensity, usually at cell cortex, preserving cell boundaries. This method works only with seeds provided as *Mask image* or *QCONF file*. Moreover, masks should be larger than the object itself. **Window** parameter stands for the size (odd) of the sampling window used for computing local mean intensity.

**Post-processing section** - it covers filtering of results applied after segmentation. The options are:

• **Hat filter** - it tries to remove small inclusions in contour that typically came from vesicles located near cell edge. The algorithm is described [here](#).
  - **srAlev** - acceptance level beyond the inclusion is removed
  - **srNum** - number of inclusions to remove. All they must have rank above **srAlev**. If this parameter is set to 0, any inclusion with rank above **srAlev** will be removed.
– *srWindow* - size of the processing window in pixels. Smaller window is more sensitive to small inclusions.

- Binary filter - stands for the final filtering, the same algorithm are used as in *Inter-processing section*.

- Cut output - output mask will be cut by input mask. This option assures that resulting mask is not larger than the seed mask.

**Display options section** - allows to show real time preview of each segmented frame and seeds computed as results of *Iter-processing* binary masks. This option can be used for verifying *Shrink power* and *Expand power* settings.

### 11.2.1 Random Walker Segmentation Workflow

If segmentation ends too early (e.g. result is very similar to seeds) one can open Fiji Console (*Window* → *Console*) and check reason of stopping and relative error. If process stops due to reaching relative error in the first few iterations, one can adjust *Rel error* accordingly.

### 11.3 Mask generator

This plugin can convert cells contours into binary image mask. The cell shape is represented by white area being a filled cell contour whereas the background in black. Masks are widely used in computer graphics for selecting regions of image for processing and analysing. ImageJ is also equipped with relevant procedures that allow for explicit processing masked regions. Therefore, this plugin make it possible to continue analysis of the sample outside the QuimP infrastructure.

Mask Generator plugin works with *QCONF* files saved by BOA module. It is not possible to use it with old file format (paQP) unless it has been converted to *QCONF* by Format Converter (available from QuimP Toolbar menu). By default, the mask image is displayed on the screen and saved on disk at location of input *QCONF* file with suffix *snakemask*.

This plugin supports ImageJ macro language. It can be called as:

```java
run("Generate mask","filename=[C:/Users/C1-talA mNeon.QCONF]")
```

### 11.3.1 Suggested workflow

- Run Mask Generator plugin from QuimP toolbar (Figure 2).

- Point to *QCONF* file to process. This plugin does not support old *paQP* files (but they can be converted to *ne* file format by Format Converter, refer to section 13).

- Binary mask image, converted from contours stored in *QCONF* file by BOA module will be displayed on the screen and saved on disk (Fig. 3). Default saving location is the location of opened *QCONF* file. The quality of mask depends on the quality of segmentation and the number of nodes configured in BOA module.
• Use Edit→Selection→Create Selection to convert binary mask to ImageJ ROIs. Then, it can be populated through ROI manager to e.g. source image.
12 Protrusion tracking

Protrusion Analysis module allows investigating protrusion formation and dynamics.

Protrusions are detected by finding local maxima in the motility map. After decoding from the motility map coordinates (outline index, frame) to Cartesian coordinates (x, y, time), those points are considered as origins of the protrusions. Every origin point can be tracked backward and forward in time as long as its velocity is above certain level, related to the velocity of origin point.

The module requires QCONF file that contains full description of QuimP analysis. Particularly, the BOA, ECMM an Q Analysis modules should be run on QCONF before using Protrusion Analysis.

The user interface is shown below.

![Protrusion Analysis module dialog](image)

- **Options section** - contains mandatory settings for peaks detection.
  - *Drop* - defines how long the origin point $p(t_0)$ from time frame $t_0$ should be tracked forward and backward in term of the change of its velocity in time. The point for time frame $t$, $p(t)$ is tracked as long as its velocity $v_{p(t)}$ meets the criterion $v_{p(t)} > v_{p(t_0)} \times (1 - Drop)$.

- **Info section** - shows basic information about found number of peaks, data range and gradient position.

- **Map plots** - allows to select what map plots are produced after analysis. The *Maxima* map contains also peaks points and tracks.

- **Outline plots section** - allows to plot cell outlines colored according to chosen algorithm. E.g. selecting *Plot type*→*MOTILITY* and *Mot Thr*=0, one will get colored only those parts of outline that have velocity above 0.

- **Maxima plot section** - contains different methods of data visualization.
• Dynamic plot section - allows to produce image stacks with peaks and tracks changing in time.

• Polar plot section - saves on disk polar plot. Polar plot represents local velocity of the cell membrane averaged over time for each node (owing ECMM algorithm, the cell contour can be interpolated to any real number of nodes that can be tracked forward and backward in time). Point on the contour that is closest to location of chemotactic gradient source is considered as the first one at polar coordinate $\theta = 0^\circ$.

Every time when Apply button is used, the module runs new analysis and produces all plots selected in relevant sections.
13 Data Files Explained

13.1 Parameter files - new format vs. old format

The latest QuimP introduces a new file format called QCONF\(^8\). The QCONF is based on human-readable JSON format and it is designed to hold all results evaluated by QuimP on every stage of data processing, together with configuration parameters, algorithm settings, etc. Initially, the QCONF is generated by BOA plugin together with stQP file (the same statistical measurements are also contained in QCONF, stQP file is saved separately for convenience sake). Remaining modules depend on QCONF, thus they read and write all data from/to this file. The QCONF is not replacement for ”old” formats - it rather extends them and allows for easy sharing of results between different QuimP modules, restoring work from last point and keeping the whole QuimP configuration in one place.

Currently, QuimP understands both formats, but its behavior depends on the status of tick box available in QuimP Toolbar (Figure 2) and on format loaded to module:

- **Use new file format** is selected - only QCONF files are shown in file chooser\(^9\). A QCONF loaded to QuimP module will be updated and saved back. Files in previous format (paQP, snQP, maQP, stQP.csv) are not saved but they can be optionally regenerated by Format Converter\(^10\) in the same directory. This is recommended approach.

- **Use new file format** is deselected - both configuration files (paQP and QCONF) are shown in file chooser. The paQP files are generated every time, even if user loaded QCONF file. The QCONF file is not updated or generated if user loaded paQP.

Relations between module and file are summarized in Table 1. Legend for Table 1 is as follows:

- **N** - file is created.
- **M** - file is modified - new data are appended to it.
- **C** - file is changed - some data are replaced.

Note
The QCONF file can be loaded to Matlab using one of the free JSON parsers (tested with JSONlab\(^{11}\)).

13.1.1 Conversion between formats

QuimP supports conversion between old paQP and new QCONF formats. Simple tool for this purpose is available from the QuimP bar (see Figure 2) under Tools menu or in extended version as separate module (see Figure 13). The module additionally allows to extract numeric data from QCONF and save them in csv files.

\(^8\)above QuimP
\(^9\)This feature may not work correctly on Windows systems
\(^10\)Available from QuimP Toolbar Tools → Format Converter
\(^11\)http://uk.mathworks.com/matlabcentral/fileexchange/33381-jsonlab--a-toolbox-to-encode-decode-json-files
Table 1: Relation among modules and generated files

<table>
<thead>
<tr>
<th></th>
<th>paQP</th>
<th>snQP</th>
<th>maQP</th>
<th>stQP.csv</th>
<th>QCONF</th>
<th>pgQP</th>
<th>svg</th>
<th>tiff</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOA</td>
<td>N</td>
<td>N</td>
<td>M</td>
<td>N</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECMM</td>
<td>C</td>
<td>M</td>
<td>M</td>
<td>M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ANA</td>
<td>M</td>
<td>M</td>
<td>N</td>
<td>M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q Analysis</td>
<td>N</td>
<td>M</td>
<td>N</td>
<td>N</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 13: Format converter dialog.

Conversion between formats

Conversion tool is available from either the QuimP bar or Format Converter module under Convert any button. After selecting proper input file - QCONF or paQP, the opposite format is saved in the same folder. The following rules will apply:

1. If paQP is an input file, it must be the first one with suffix _0.paQP.
2. The QCONF format stores separate segmentation settings for each frame - only settings from the first frame are saved in paQP.
3. Order of outline nodes in QCONF can be randomly shifted forward or backward by one node during conversion from paQP.
4. paQP format stores data with precision limited to two decimal places.

Extracting data from QCONF format

The Format converter module (Figure 13) allows to save selected parameters evaluated during QuimP workflow as csv files. They are not processed in any way (e.g. scaled to different units) and mostly
coincide with content of snQP or stQP.csv files (except of q11 files checkbox that generates stQP files). This tool works only with QCONF files that should be first loaded by Load QCONF button. Conversion process is initiated by Generate button. Output files are saved in the same folder as input QCONF.

13.2 Parameter Files - paQP Files

A parameter file contains text and has the extension .paQP. Both QuimP’s plugins and Matlab functions use the parameter file to locate files associated with an analysis and also to store data such as the pixel size, frame interval, and start frame. In addition, it stores the parameters used for segmentation (the last used parameters).

The first line identifies the file as a QuimP parameter file, and contains the creation date. The second is random identifier. The third is the absolute path to the image used for segmentation.

In general, the contents of a parameter file should not be changed, but you may wish to alter the paths to image files if you later move them.

13.3 Snake Data - snQP files

The .snQP file contains data relating to the nodes of cell outlines (snake is a reference to active contours being described as snakes). Comment lines begin with a #. Data for frame $f$ begins with the comment line #frame $f$, followed by a single integer value indicating the number of nodes that make up the outline ($N$). The following $N$ rows hold the data for the nodes. The columns are as follows:

- **Node Position** - The normalised position of the node in relation to node zero, $n_0$ (see section 8.1).
- **X Coord** - The horizontal pixel coordinate of a node on the image used for segmentation.
- **Y Coord** - The vertical pixel coordinate of a node on the image used for segmentation.
- **Origin** - The position from which a node originated from on the outline at the previous frame (see section 8.1).
- **Global Origin** - The position from which a node originated from on the outline at the first segmented frame (see section 8.1).
- **Speed** [microns per second] - The speed at which a node travelled between frames, as determined by ECMM.
- **Fluor_Ch$\$** - The intensity value assigned to a node by ANA (see section 9) for the channel number denoted by $. This value is the maximal 3x3 average intensity measured at the node’s local cortical region.
- **Ch$\$ x** - The horizontal pixel co-ordinate on the fluorescence image at the point where Fluor_Ch$\$ was measured, i.e. the co-ordinate where the maximum intensity occurred.
• Ch$y$ - The vertical pixel co-ordinate on the fluorescence image at the point where Fluor.Ch$y$ was measured, i.e. the co-ordinate where the maximum intensity occurred.

It is possible to store data for 3 fluorescence channels ($\mathcal{S} = \{1, 2, 3\}$) within the .snQP file. Missing data is denoted by negative values.

13.4 Frame statistics - stQP files

The statistics file, with the extension .stQP, contains whole cell statistics for each frame (rather than node associated data). Data is written as comma separated values which can be opened easily as a spreadsheet. The file is split into two section. Data in the top section is computed by BOA and relates to cell morphology and movement of the cell centroid. Data in the lower section relates to cell fluorescence and was computed by ANA (data is listed separately for all 3 available channels). Missing data is denoted by $-1$.

The cell centroid is computed as the weighted centre of the polygon formed by the cell outline. The measures computed by BOA are as follows:

This file is generated and updated regardless of selected file format (QCONF or paQP). Refer to table 1

• X-Centroid [pixels] - Horizontal pixel co-ordinate of the cell centroid.
• Y-Centroid [pixels] - Vertical pixel co-ordinate of the cell centroid.
• Displacement [microns] - Distance the cell centroid has moved from its position in the first recorded frame.
• Distance Travelled [microns] - Sum of the centroid displacements between frame, i.e. the total distance over which the centroid has moved.
• Directionality - Persistence in direction, calculated as Displacement/Dist.Travelled (chemotaxis index). A value of 1 reveals that a cell has moved in a straight line. Decreasing values denote a cell moving increasingly erratically.
• Speed [microns per second] - Speed at which the centroid moved between the current and previous frame.
• Perimeter [microns] - Length of the cell perimeter (segmented outline).
• Elongation - An ellipse is fitted to the cell outline and the major/minor axis used to compute the elongation of the cell’s shape. $Elongation = \frac{major\ axis}{minor\ axis}$. Note that a value of 1 does not necessarily represent a perfectly circular cell, only a circular fitted ellipse.
• Circularity - A measure of circularity defined by the following equation: $\frac{4\pi\ Area}{Perimeter^2}$. A value of 1 reveals the cell’s outline to be perfectly circular.
• Area [microns$^2$] - Cell area.

The measures computed by ANA are as follows:
- **Total fluo.** \([\text{pixelintensity}]\) - Total fluorescence. Sum of all pixel intensities within the cell outline.

- **Mean fluo.** \([\text{pixelsintensity}]\) - Mean fluorescence. Average intensity of pixels within the cell outline.

- **Cortex width** \([\text{microns}]\) - Width of the cortex, as specified by the user (see section 9).

- **Cyto. area** \([\text{microns}^2]\) - Area of the cytoplasm (area of the whole cell minus the cortex area).

- **Total cyto. fluo.** \([\text{pixels intensity}]\) - Sum of all pixel intensities within the cytoplasm.

- **Mean cyto. fluo.** \([\text{pixels intensity}]\) - Average pixel intensity within the cytoplasm.

- **Cortex area** \([\text{microns}^2]\) - Area of the cortex.

- **Total cortex fluo.** \([\text{pixels intensity}]\) - Sum of all pixel intensities within the cortex.

- **Mean cortex fluo.** \([\text{pixels intensity}]\) - Average pixel intensity within the cortex.

### 13.5 QuimP Maps - maQP files

The images produced by Q Analysis are spatial-temporal maps of motility, convexity, and fluorescence. The vertical axis represents time, with frame 1 at the top. The horizontal axis represents positions along the cell outline, the length of which has been normalised to 1 at every frame. Outlines can be thought of as having been ‘cut’ at position zero, laid along the horizontal axis, and stacked below one another, hence maps are cylindrical (wrap around onto themselves on the horizontal axis).

The node randomly designated as begin node zero (\(n^0\)), at frame 1, is mapped to the top left pixel. Data from ECMM is used to track the position of \(n^0\) throughout all the frames, and is always positioned at the left most pixel at each frame. All other nodes are positioned along the horizontal axis according to their distance from \(n^0\) along the cell perimeter. Values between nodes are estimated using linear interpolation.

If the number of frames is below the specified map resolution, then maps are scaled vertically, hence a row of pixels may be an interpolated value between frames.

As well as producing .tif images, maps are also saved as text images with the extension .maPQ. Unlike the .tif maps, these are not scaled vertically, so each line of values contains the data for a single frame. It is these maps that should be used for further analysis.

Similarly, four additional maps are produced to aid further analysis:

- **Motility Map.** Pixels are coloured according to node speed, as calculated by ECMM. Red shades represent expanding regions, blue shades contracting regions. Pixel values within the tiff image are scaled to fill the colour spectrum. The map file extended _motilityMap.maPQ contains un-scaled values, in microns per second.
• **Fluorescence Maps.** A fluorescence map is produced for each channel that data has been recorded into. The fluorescence map images display pixel intensities, as extracted by the ANA plugin. Files extended \textit{.fluoCh\$\_mapQ} contain the respective data. Fluorescence value is a mean of pixel intensities sampled within 9-point stencil for each node of the cortex outline (see section 9).

• **Convexity Map.** Represents the curvature of the cell, measured in the range \([-1, 1]\), where negative values are concave (blue), and positive convex (red). As with the motility map, values are scaled to fill the colour map. Files extended \textit{\_convexityMap\_mapQ} contain the respective data (un-scaled).

• **Co-ordinate Map (a.k.a. Position Map).** As described in section 8.1, each node has an associated position. The co-ordinate map, rather than contain values regarding motility, fluorescence or convexity, instead contains the position values of nodes. The main purpose of the co-ordinate map, along with the origin map, is for tracking positions through time (see section 14.3).

• **Origin Map.** As described in section 8.1, each node has an origin, the position a node originated from on the previous frame. The origin map contains origin values and can be used, along with the co-ordinate map, to track positions through time (see section 14.3).

• **xMap.** Contains horizontal image pixel co-ordinates (those on the image used for segmentation) relating to map pixels.

• **yMap.** Contains vertical image pixel co-ordinates (those on the image used for segmentation) relating to map pixels.

### 13.6 Scalable vector graphics output - svg files

Files extended with \textit{.svg} can be viewed natively in most internet browsers (Windows Explorer requires the Adobe SVG viewer), or opened and edited in graphics software (e.g. Inkscape, free software for mac). The Scalable Vector Graphics (svg) file format can be viewed at any desired resolution.

• **Cell track.** An overlay of all cell outlines coloured according to frame number. Files extension \textit{\_track.svg}.

• **Cell motility movie.** Data contained within the motility/fluorescence/convexity map is displayed on the cell track. Extension \textit{\_motility.svg}.

### 13.7 BOA plugins stack configuration - pgQP file

This file stores configuration of plugin stack together with configurations of active plugins (see Figure 4 and chapter 7.3). This file is not related to any loaded data therefore it can be exchanged between projects. Complex plugin stack configuration is stored also in \textit{QCONF} file.
14 MATLAB Functions

Archive with Matlab routines mentioned in this section is available on QuimP web page (section Download QuimP)\(^\text{12}\)

Matlab routines work with old data format only (*.paQP, *.snQP, etc.). To use them with QCONF file, it has to be first converted to the old format by Format Converter (Section 13). It is also possible to load QCONF to Matlab using JSON readers.

QuimP outputs a large amount of data for each cell analysed. You may want to write custom scripts for analysis, but we provide a set of MATLAB functions to remove the hassle of loading/organising data, and performing simple operations, such as plotting maps. We hope to make data as accessible and as explorable as possible to allow adaptation to a users specific goals.

Help documentation is included with each function which can be accessed in the usual way by typing `help functionName` at the MATLAB command prompt. At the end of this document is a walkthrough analysis using the provided test images (see section 15).

14.1 Loading data - `readQanalysis.m`

The first step is to launch the script `readQanalysis.m` which handles loading of data from multiple cells. Given a directory, it will search that directory, and all sub-directories, for .paQP files. For each parameter file that is found an analysis structure is built. As data is read from sub-directories, you may organise your separate analyses into sub-directories, but placing all files into the same directory is still possible. Missing files are skipped, hence it is not necessary to have run all the QuimP plugins.

Loading data relies on the maintenance of file names imposed by the QuimP plugins, and requires associated files to be present in the same directory as the parameter file. The exceptions to this are the images used for segmentation and fluorescence measurements. Paths to these images are stored in full to allow separation of analysis files from image data. If images are moved, and subsequently cannot be located, the directory where the parameter file is stored will be searched. You may edit the .paQP file to alter paths to the images if you wish (note that images are not loaded into memory by `readQanalysis.m`, instead the function checks only that they exist and sets a path to them).

The output of `readQanalysis.m` is an array of structures, `C`, each element holding data for a single analysed cell. The contents of an analysis structure is as follows (\(F\) = number of frames, \(N_f\) = number of nodes at frame \(f\)):

- **name** [string] - File name element common to all associated files (name of the parameter file).
- **index** [integer] - Cell ID, in order read in.
- **PATH** [string] - Directory of the parameter file.
- **$FILE** [string] - Filenames of QuimP output.

\(^{12}\)http://www2.warwick.ac.uk/fac/sci/dcs/people/till_bretschneider/quimp/test_data
• **$TIFF** [string] - Filenames of an image sequences.

• **outlines** [cell array ($F \times 1$)] - Holds node associated data. Each element contains a matrix of size $N^f \times 6$, each row being a node. Column headers are [Position, X-coord, Y-coord, Origin, Global origin, Speed].

• **outlineHeaders** [cell array (1 x 6)] - Descriptions of column measures within outlines, as stated above.

• **fluo** [cell array ($F \times 1$)] - Holds node fluorescence data for all three channels. Each element contains a 3D matrix of size $N^f \times 3 \times 3$. The first dimension represents nodes, second the channel number, and third the measure. The measures are [Intensity, X-coord, Y-coord], where the x and y co-ordinates provide the location of sampling (see section 9). For example, the intensity sampled at node 23, on channel 2 is located at (23,2,1).

• **fluoHeaders** [cell array (1 x 3)] - Descriptions of measures within fluo, as stated above.

• **nbFrames** [integer] - The number of frames.

• **startFrame** [integer] - The first frame segmented relative to the image used for segmentation.

• **endFrame** [integer] - The last frame segmented relative to the image used for segmentation.

• **frames** [vector ($F \times 1$)] - Vector of the segmented frames relative to the image used for segmentation.

• **PixelSize** [double] - Pixel size in microns (image scale).

• **frameInterval** [double] - Frame interval in seconds.

• **R** [vector (1 x 4)] - Pixel co-ordinates of a bounding box encompassing all movement of the cell. $R = [x\ min, x\ max, y\ min, y\ max]$.

• **maxSpeed** [vector ($F \times 1$)] - For each frame the maximum node speed is calculated. This is useful for scaling plots.

• **stats** [matrix ($F \times 11$)] - Holds whole cell statistics relating to the cell centroid and cell shape (see section 13.4). Rows contain data for frames. The column headers are ['Frame', 'x-Centroid', 'Y-Centroid', 'Displacement', 'Distance Travelled', 'Directionality', 'Speed', 'Perimeter', 'Elongation', 'Circularity', 'Area']

• **statsHeaders** [cell array (1 x 11)] - Descriptions of column measure within stats, as stated above.

• **fluoStats** [matrix ($F \times 3 \times 11$)] - Holds global cell statistics relating to the cell fluorescence (as described in section 13.4). The first dimension is frame number, second the channel number, and third the measure. The measure headers are ['Frame', 'Total Fluo.', 'Mean Fluo.', 'Cortex Width', 'Cyto. Area', 'Total Cyto. Fluo.', 'Mean Cyto. Fluo.', 'Cortex Area', 'Total Cortex Fluo.', 'Mean Cortex Fluo.', '%age Cortex Fluo.']. Missing data is represented by negative values, typically $-1$. 

41
• **fluoStatHeaders** [cell array (1 × 3)] - Descriptions of the measures in the third dimensional within *fluo*, as stated above.

• **cortexWidth** [vector (3 × 1)] - Holds for each channel the cortex width specified when running ANA.

• **Map** [matrix (F × MapRes)] - Maps read from .maQP files (see section 13.5). A QuimP map in MATLAB is a 2D matrix, rows being frames, columns being discrete points along the cell outline.

• **forwardMap** - see section 14.3.

• **backwardMap** - see section 14.3.

### 14.2 Function Overview

Functions prefixed with ‘read’ are used by *readQanalysis.m* and so generally are not used independently, but can be if desired. For details of usage please refer to the functions help by typing `help functionName` at the MATLAB command prompt.

• **buildTrackMaps** - Constructs the *forwardMap* and *backwardMap* based upon the co-ordinate and origin maps. These are used to track through QuimP maps. See section 14.3 for details.

• **mapLookup** - Extract values from maps by specifying a window or region. This can be used, for example, to extract data along tracked paths.

• **plotMap** - Plot a QuimP map using specified colour map limits.

• **plotMotility** - Plots a cell outline with nodes coloured according to their speed of movement.

• **plotOutline** - Plots a cell outline.

• **trackBackwards** - Utilises the *backwardMap* to track backwards through a map, from a specified point, in accordance with the ECMM tracking data.

• **trackForwards** - Utilises the *forwardMap* to track forwards through a map, from a specified point, in accordance with the ECMM tracking data.

• **trackForwAcc** - Similar to *trackForwards* but functions at sub-pixel resolution. More accurate but slower.

• **xcorrQ** - Perform cross-correlation and auto-correlation of .maPQ maps.

### 14.3 Tracking Maps

The term *tracking* in this sense refers to being able to pick a position on the perimeter of a cell and identify its corresponding position in the following frames, and hence, track a position over time. The trace of a position, computed by ECMM, can be plotted on top of a QuimP map.
A QuimP map in MATLAB is a 2D matrix, rows being frames \( (f) \) and columns being discrete locations along the cell outline \( (l) \). An incorrect view may be that a map pixel \( p \) at frame \( f \), and location \( l \), \( (p^f_l) \), tracks to the pixel directly below \( (p^{f+1}_l) \). This is not the case, \( p^{f+1}_l \) does not necessarily originate from \( p^f_l \). The origin map must be consulted to identify the correct location.

[Maps that enforce \( p^f_l \) tracking to \( p^{f+1}_l \) become heavily distorted, and certain regions lose resolution severely.]

To track from \( p^f_l \) to \( p^{f+1}_l \) we require the correct matrix column index at \( f+1, l_2 \). Firstly, consult the co-ordinate map at \( p^f_l \) to identify the position on the cell outline. Next, extract the values in row \( f+1 \) from the origin map. The index \( l_2 \) is simply the index of the closest origin value to \( p^f_l \)'s position (this can also be done at sub-pixel resolution for more accuracy). The process is repeated to find \( p^{f+2}_l, p^{f+3}_l \), etc. In a similar way, positions can be tracked backwards in time.

This tracking procedure is implemented in the provided MATLAB functions. The function buildTrackMaps.m creates two additional maps, forwardMap and backwardMap, and is called when data is read in. An element in the forwardMap, for example at \( p^f_l \), contains the correct column index for \( l_2 \) to locate \( p^{f+1}_l \). Similarly, backwardMap contains the correct values for finding \( p^{f-1}_l \).

Functions trackForwards.m, trackForwAcc.m and trackBackwards.m, given a frame, location, and number of frames to track over, will return complete traces for you. Consult the help for these functions for details of usage and the walkthrough for an example.
15 Walkthrough analysis

Matlab routines and walkthrough data mentioned in this section are still available from QuimP web page\textsuperscript{13}

The folder QuimP\_walkthrough\_files contains 3 tiff image sequences which you can analyse (images are courtesy of Evgeny Zatulovskiy, Rob Kay Group, MRC Laboratory of Molecular Biology).

- ‘QW\_channel\_1\_actin.tif’- Actin label. Image and has been background corrected and contrast enhanced.
- ‘QW\_channel\_2\_neg.tif’ - Negative stain. The cell appears as a shadow on a bright background, which has then been inverted.
- ‘QW\_channel\_2\_seg.tif’ - For segmentation we shall use the negative stain channel. A 1 pixel Gaussian blur has been applied, the background removed, and contrast enhanced.

**Step 1.** Open ImageJ and launch the QuimP bar [Plugins → QuimP → QuimPBar]. Open the image ‘QW\_channel\_2\_seg.tif’. Launch BOA from the QuimP bar.

**Step 2.** At the prompt check the scale is correct (2 second frame interval, pixel width 0.2 microns).

**Step 3.** Using the polygon selection tool, create a selection encompassing the cell. This can be very rough. Click *Add cell*.

**Step 4.** Adjust the parameters to get a good segmentation. Click *SEGMENT* and wait for completion.

**Step 5.** Scroll through the sequence to check the segmentation result using either the scroll bar or mouse wheel. The segmentation should have completed to the last frame. If not, we will truncate the segmentation. Scroll to the last frame which successfully segmented and click *Truncate Seg*. Click *FINISH*, and provide a name for the analysis (e.g. ‘QTest’).

**Step 6.** Launch the ECMM plugin from the QuimP bar. It does not require an image. When prompted, locate the QuimP parameter file you just created (e.g QTest.paQP). ECMM will run. You can view the result and close the image.

**Step 7.** Open the image ‘QW\_channel\_1\_actin.tif’. With it in focus, launch the ANA plugin, and again select your parameter file. Choose a sensible cortex width (e.g. 1.5 microns). Make sure ‘save in channel’ is set to 1, and normalise to interior is ticked. Click *ok*. When complete, ANA will show the sample locations for the last frame.

**Step 8.** Close ‘QW\_channel\_1\_actin.tif’, and open ‘QW\_channel\_2\_neg.tif’. We will record another channel for good measure. Repeat the last step, but with the channel 2 image, this time storing data in channel 2 (which is the default), and tick ‘Sample at Ch1 locations’. ANA will now use the same sample points as computed for channel 1 (useful if you want to compute ratios between channels).

\textsuperscript{13}http://www2.warwick.ac.uk/fac/sci/dcs/people/tillbretschneider/quimp/test\_data
Step 9. Launch the Q Analysis plugin, and again choose your parameter file. Check your scale is what you expect at the top of the parameter window. We will use all the current defaults, so click RUN. Inspect your maps, all of which are automatically saved to disk.

Step 10. The displayed images have been scaled to cover the colour space. The raw values have been saved separately as text files, with the extension .maQP (e.g. QTest_0.fluoCh1.maQP). You can view them in ImageJ by opening them via [File → Import → Text Image...].

Step 11. We will now switch to MATLAB to plot some of this data. Open Matlab and open the script file ‘walkthrough.m’, which will guide you through loading and plotting data. You can use the output provided in the QuimP package, called QWalkthrough, rather than your own.
16 Historical versions

16.1 QuimP11b

1. Fixed several minor bugs.
2. Updated and tested with ImageJ 1.49a and MATLAB 2014a
3. The ECMM and Q Analysis plugins will search for other .paQP in a directory and prompt to batch process files.
4. BOA prompts to check image scale.
5. BOA can read in a previous segmentation using the LOAD button
6. When editing segmentations the user can scroll between frames without leaving edit mode
17 Contact

The QuimP software is being developed at the Systems Biology DTC at the University Of Warwick by the Till Bretschneider group (Till.Bretschneider@warwick.ac.uk). Further information, and future releases, can be obtained from http://go.warwick.ac.uk/quimp.

QuimP is under continuous development and feedback will be much appreciated. If you discover a bug, have suggestions for features, or simply find a spelling mistake, please contact the developer Piotr Baniukiewicz at p.baniukiewicz@warwick.ac.uk. Thank you for supporting our software.
References

